# Contents

**Introduction** .................................. v

**Chapter 1. What’s New?** .................................. 1

New Features in Version 10.1.1 ................................ 1

Geopolitical Boundary Changes ................................ 1

**Chapter 2. Installing Map Manager** .................................. 3

System Requirements ................................ 3

Supported Environments ................................ 3

Install Map Manager ................................ 3

Uninstall Map Manager................................ 4

**Chapter 3. Map Manager** .................................. 5

Report Studio and Map Charts ................................ 7

Start Map Manager ................................ 7

Open a Map File ..................................... 8

Create a Custom Layer ................................ 8

Making a map file available to Report Studio .................... 9

Adding a map to a map folder ................................ 9

Creating or changing a map folder ................................ 10

Import a Map from a Non IBM Source ......................... 11

Preparing Maps for Reuse in Reports ......................... 12

  Change the Map Image ................................ 12

  Add a Description to a Map ................................ 13

  Add an Alias to the Dictionary for a Map Feature .......... 13

  Find a Map Feature. ................................ 14

  Adding Language (Locale) Support ......................... 14

  Merge a Customized Map with Another Map ................ 16

**Chapter 4. Acquiring New Maps** .................................. 17

**Chapter 5. Troubleshooting** .................................. 19

Problems Importing Files ................................ 19

  Error Importing Translated Text File .................... 19

**Notices** .......................................... 21

**Glossary** ........................................ 25

A .................................................................. 25
B .................................................................. 25
C .................................................................. 25
D .................................................................. 27
E .................................................................. 27
F .................................................................. 27
G .................................................................. 27
H .................................................................. 28
I .................................................................. 28
J .................................................................. 28
L .................................................................. 28
M .................................................................. 28
N .................................................................. 29
O .................................................................. 29
P .................................................................. 29
Q .................................................................. 30

© Copyright IBM Corp. 2005, 2012
Introduction

This document is intended for use with IBM® Cognos® Map Manager. Map Manager is a Microsoft Windows program that you use to prepare maps for use in reports.

This document describes how to install Map Manager. It also describes how to
• import maps from non IBM sources
• define alternate names or abbreviations for map features
• provide multilingual support for maps

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers (http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release Notes are published directly to Information Centers, and include links to the latest technotes and APARs.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility features

This product does not currently support accessibility features that help users with a physical disability, such as restricted mobility or limited vision, to use this product.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1. What's New?

This section contains a list of new features for this release. It will help you plan your upgrade and application deployment strategies and the training requirements for your users.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).

New Features in Version 10.1.1

Listed below are new features since the last release.

Geopolitical Boundary Changes

From time to time, geopolitical boundaries of various countries and regions change to recognize new realities due to conflict and division. This release contains two map updates.

- The map of India now includes the state Lakshadweep and adjustments to the boundaries of various disputed regions. Lakshadweep is a group of islands in the Laccadive Sea located to the west of the India.
- The world and European maps now have separate regions for Serbia, Montenegro, and Kosovo. Previously, the maps showed a single region of Serbia and Montenegro, which included the Kosovo region. Kosovo is a self-declared independent state; the map reflects a separate region based on United Nations recognized boundaries.
Chapter 2. Installing Map Manager

Install IBM Cognos Map Manager if you want to
- convert maps from non IBM sources
- assign alternate names for map features
- assign alternate languages for map features

Before you install, ensure that you have administrator privileges for the computer you are installing on. If you are not an administrator, ask your system administrator to add you to the Administrator group.

System Requirements

Before you install IBM Cognos Map Manager, ensure that your computer meets the software and hardware requirements. The hardware requirements depend on your business intelligence environment. You may require additional resources, such as disk space.

The following table lists the minimum hardware and software requirements to run Map Manager.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum: 50 MB of free space on the drive that contains the temporary directory</td>
</tr>
</tbody>
</table>

Supported Environments

It is important to apply all required operating system patches and to use only the versions of other software that are supported by an IBM Cognos product. Otherwise, your product may not work properly.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).

Install Map Manager

You install IBM Cognos Map Manager on a Microsoft Windows computer. You can install it on the same computer as an IBM Cognos Business Intelligence product or component, such as IBM Cognos Framework Manager, or on a different computer.

Procedure
1. We recommend that you first close all applications that are running.
2. Insert the product disk and then open the installation menu.
   - The Welcome page of the installation wizard should appear.
If the Welcome page does not appear, in the win32 directory on the disk, double-click issetup.exe.

3. Select the language to use for the installation.
   The language you choose determines the language of the text that appears on the pages of the installation wizard.

4. On the Installation Location page, select the directory.
   If you are installing Map Manager on a computer that already has IBM Cognos BI products, you must install Map Manager in the same directory.
   If you are prompted to stop the services, click Yes.

5. Follow the directions in the installation wizard.
   On the Finish page, if you stopped the services earlier, click Start IBM Cognos Configuration and restart the services.

Results

You can now use the Microsoft Windows Start menu to start IBM Cognos Map Manager.

The installation wizard creates two log files in the installation_location\instlog directory. The install log file records the activities that the installation wizard performs while transferring files. The summary-error log file records the components you install, disk space information, your selections in the transfer dialogs, and any errors the installation wizard encounters while transferring components. The log file names include the product name, version, build number, and time stamp.

Uninstall Map Manager

If you no longer require IBM Cognos Map Manager, you can uninstall it using the uninstall program. It is important to use uninstall programs to completely remove all files and modifications to system files.

The Uninstall wizard also removes IBM Cognos Framework Manager if it is installed in the same location.

Before you uninstall, ensure that you back up any data that you may need in the future.

Procedure

1. From the Microsoft Windows Start menu, click Programs, installation_folder, Uninstall IBM Cognos.
   The Uninstall wizard appears.

2. Follow the instructions to uninstall.

Results

The Cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files. To find the log file, look in the Temp directory.

Uninstalling does not remove any files that changed since the installation, such as user data files. Your installation location remains on your computer, and you retain these files until you delete them using Microsoft Windows Explorer.
Chapter 3. Map Manager

IBM Cognos Map Manager is a Microsoft Windows program that you use to prepare maps for use in reports. You can add aliases and languages to the sample maps that are provided. You can convert custom maps from a non IBM source to IBM Cognos map format (CMF) and then add aliases and languages. Map Manager supports maps that use geoset format (GST), such as those from MapInfo, our OEM-preferred provider for map data.

You can perform other actions with map information using a combination of MapInfo and IBM Cognos products. For example, you can create maps in MapInfo Professional, prepare the maps for use in Map Manager, define and run a report that uses maps in IBM Cognos Report Studio, and then view the report in Report Viewer.
Within each of the applications, you can perform certain actions as shown in the following table.

<table>
<thead>
<tr>
<th>Application</th>
<th>Actions permitted</th>
<th>Actions not permitted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Viewer</td>
<td>Drill through</td>
<td>Zoom</td>
</tr>
<tr>
<td></td>
<td>Get tool tips</td>
<td>Change layer content</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adjust mismatched data</td>
</tr>
<tr>
<td>Report Studio</td>
<td>Choose map layers</td>
<td>Change map content</td>
</tr>
<tr>
<td></td>
<td>Apply default map colors</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add aliases within report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Define rules for color based on data source queries and filters</td>
<td></td>
</tr>
<tr>
<td>Map Manager</td>
<td>Convert maps from MapInfo format to IBM Cognos format</td>
<td>Change map content</td>
</tr>
<tr>
<td></td>
<td>Create custom layers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Change the preview image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add a description</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Define aliases for feature names</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add languages</td>
<td></td>
</tr>
<tr>
<td>MapInfo Professional</td>
<td>Create new objects</td>
<td>Add languages</td>
</tr>
<tr>
<td></td>
<td>Create new layers in MapInfo tab format</td>
<td>Define rules for color based on data sources</td>
</tr>
</tbody>
</table>

Before you use Map Manager, you should be familiar with basic map terminology and the reporting requirements for your organization.

Map Manager manages the following types of information in map files:

- **Preview images**
  Shows thumbnail images of the map. You can preview the general appearance of the map. Preview images do not contain data.

- **Layers**
  Shows thematic groupings of features. For example, it may include regions such as provinces, territories or states, categories such as major and minor cities, or user-created custom layers.

- **Features**
  Specifies the points or named elements on a map. Text labels identify points on the map.

- **Base language**
Identifies the default language for labels. Used when the user's preferred language does not exist in the map file. In Report Studio, this is the language for labels at run time if the user locale is not a supported language in the map file.

- Dictionary
  Lists the feature names and any aliases for each available language.

---

**Report Studio and Map Charts**

Reports in IBM Cognos Report Studio use maps to represent data that can be displayed spatially. For example, a map can show things such as geographical area, floor plans in a building, seats in an airplane, or parts of the human body.

A map in IBM Cognos BI consists of a collection of layers. Each layer contains different information that is determined either from the map file or from your data source. A layer is like a transparency that is placed on top of the base map. Each layer adds more information to the map. For example, a map of the world may contain one layer with information related to countries and another layer with information related to cities.

At run time, Report Studio queries the data source to retrieve the data to show in the map chart. Map layers and points (map features) on the map chart use the numeric values of the data to display the appropriate color. If the text for the labels that appears on the map differs between the map file and the data source, you must set up aliases in the map file before you run the query. This ensures that the appropriate colors are shown. Report authors can choose to set up the aliases at run time for one-time reporting needs.

At run time, the map label text appears in the language of the user’s locale setting. For example, users who have a German user locale see the map labels in German, while users who have a French user locale see the map labels in French. If the map file does not contain the language of the user’s locale, then the labels appear in the base language that is specified in the map file. You can change the base language.

---

**Start Map Manager**

Start IBM Cognos Map Manager when you want to import maps from non-IBM sources or manage existing IBM Cognos map files.
Procedure

From the Microsoft Windows Start menu, click Programs, installation_folder, IBM Cognos Map Manager.

Open a Map File

Open an existing IBM Cognos map file (.cmf) to view the map, to create custom layers, or to add aliases, a description, or languages.

You must use the import wizard to open a map file from a non-IBM source.

If you want to use the map as the basis of a new map, save it using a different name.

You can also resize the application window.

Procedure

1. From the File menu, click Open.
2. In the Look in list, click the drive, folder, or Internet location that contains the IBM Cognos map file (.cmf) that you want to open.
3. In the folder list, locate and open the folder that contains the map file.

   Tip: Sample map files are in the installation_location/maps directory.
4. Click the file, and then click Open.

Related tasks:

“Import a Map from a Non IBM Source” on page 11

Before you can use a custom map in IBM Cognos Report Studio, you must convert it to an IBM Cognos map file (.cmf). For this release, MapInfo geosets (*.gst) and related files are supported.

Create a Custom Layer

Create a custom map layer based on existing features.

Procedure

1. From the Tools menu, click Define Custom Layers.
2. Click Add.
3. In the New Layer dialog box, type a name for the layer.
4. From the list, select the layer on which you want the new layer to be based.
5. Click OK.
6. To assign a color to the new layer, click the color bar.
7. Select the color from the palette and click OK.
8. With the new layer highlighted, click the Features tab.
9. On the Features tab, type a name for the group of features you want to associate with this layer, and add features from the Available features list.
10. Click OK.
Making a map file available to Report Studio

To make a map file available to Report Studio authors, you must copy the file to one or more map files locations.

Each time you change a map file, you must update the map files locations.

**Procedure**

1. Save the map file.
2. Add the new or changed map file to the **Map files location** specified in the **Environment** properties in IBM Cognos Configuration on the computer where the dispatcher is installed.
   
   If your IBM Cognos BI environment uses more than one dispatcher, you must copy the new or changed map to the map files location specified on each dispatcher computer. If you do not update the map files location on all dispatcher computers, the Report Studio author might receive an error, or the author might work with an out-of-date map.
3. In Report Studio, create a map report to verify that the new or updated map is available.

**Results**

A new map appears at the bottom of the maps list in the Choose Map window in Report Studio. You can add the map to a map folder and create new map folders.

**Related tasks:**

"Adding a map to a map folder"

You can add a map to a map folder and change the order maps appear in folders.

---

**Adding a map to a map folder**

You can add a map to a map folder and change the order maps appear in folders.

You can also create new map folders.

**Before you begin**

For a new or changed map to be accessible to IBM Cognos Report Studio, a copy of the map must exist in the **Map files location** specified in the **Environment** properties in IBM Cognos Configuration on the computer where the dispatcher is installed. If your IBM Cognos BI environment uses more than one dispatcher, you must copy the new or changed map to the map files location specified on each dispatcher computer. If you do not update the map files location on all dispatcher computers, the Report Studio author might receive an error, or the author might work with an out-of-date map.

After you add a map to the map files location, the map appears at the bottom of the maps list in the Choose Map dialog in Report Studio. To add a map to a folder you edit the MapGroups.xml file.

**Procedure**

1. On the computer where the IBM Cognos BI gateway is installed, from the `installation_location\webcontent\pat\res` directory, open MapGroups.xml in a text or XML editor.
   
   - To add a map to a folder, add or copy a `<map>` entry to the `<folder>` node.
For example, to add the Ontario map to the Americas group, under `<folder idsLabel="IDS_MAP_GROUP_LABEL_AMERICAS">` add the entry

```xml
<map id="ontario.cmf"/>
```

The position of the entry is important. Maps appear in the order in which the `<map>` entries appear in the `MapGroup.xml` file.

- To change the order that existing maps appear in the folder list in the Choose Maps window, change the order of the `<map>` entries.

Maps appear in the order in which the `<map>` entries appear in the `MapGroup.xml` file. The maps are not arranged alphabetically. For example, using the following `<map>` entry order, Germany appears before France in the maps list in Report Studio.

```xml
<map id="germany.cmf"/>
<map id="france.cmf"/>
```

2. Save the `MapGroups.xml` file.

3. In Report Studio, create a map report to verify that the maps appear in the correct folder and order in the Choose Map dialog.

**Results**

Before you upgrade to a new version of IBM Cognos BI, save a copy of the `MapGroups.xml` file. When you upgrade, the file is overwritten and you must manually reapply the changes.

**Creating or changing a map folder**

When you first use Report Studio, the folders and maps that appear in the Choose Map window represent the maps that are included with IBM Cognos Business Intelligence.

You can change the name and order of existing map folders, or create new map folders. You can add folders to the top level, or have both maps and folders nested in a parent folder. To change the display order of an existing folder, you edit the `MapGroup.xml` file. To create a folder, you must edit the `MapGroup.xml` and, depending on how many languages your environment supports, one or more `reportstudio_language.xml` files.

**Procedure**

1. On the computer where the IBM Cognos BI gateway is installed, from the `installation_location\webcontent\pat\res` directory, open `MapGroups.xml` in a text or XML editor.

2. Add a map folder entry or change the order of existing entries.

   - To create a map folder, add a `<folder>` node in the position you want the folder to appear in the Choose Maps window and then add the required `<map>` entries.

   - You must use the correct format for folder and map entries, including a closing tag for each folder node.

   You can create new top-level folders, or you can nest map folders. With the following example, in the Choose Map window, a Provinces folder appears under the Canada map. Americas is the parent folder.

```xml
<folder idsLabel="IDS_MAP_GROUP_LABEL_AMERICAS">
  <map id="centralamerica.cmf"/>
  <map id="southamerica.cmf"/>
  <map id="canada.cmf"/>
  <folder idsLabel="IDS_MAP_GROUP_LABEL_PROVINCES">
    <map id="ontario.cmf"/>
  </folder>
</folder>
```
To change the order of an existing folder, move the folder entry and included maps to the new location.

3. If you added a folder to the MapGroups.xml file, on the computer where the IBM Cognos BI gateway is installed, from the installation_location\webcontent\pat\res directory, open reportstudio_en.xml in a text or XML editor.

4. To locate the relevant section of the file, search for Map_Group.

5. On a new line, create a MAP_GROUP entry following the format of the existing entries. MAP_GROUP_LABEL_NAME must match a MAP_GROUP_LABEL_NAME entry in the MapGroups.xml file. "List Item Label" is the name that appears in the Choose Map window. The new entry for the Provinces folder example in the MapGroups.xml file would be:

   <string id="IDS_MAP_GROUP_LABEL_PROVINCES" type="List Item Label">Provinces</string>

6. Edit additional reportstudio_language.xml files as required.

7. In Report Studio, create a map report to verify that the folders and maps appear correctly in the Choose Map window.

Results

Note: Before you upgrade to a new version of IBM Cognos BI, save a copy of the MapGroups.xml and reportstudio_language.xml files. When you upgrade, the files are overwritten and you must manually reapply the changes.

Import a Map from a Non IBM Source

Before you can use a custom map in IBM Cognos Report Studio, you must convert it to an IBM Cognos map file (.cmf). For this release, MapInfo geosets (*.gst) and related files are supported.

If the custom map file contains attribute data other than identifiers and aliases, the data is ignored by IBM Cognos Map Manager. The custom map file can use any coordinate system.

To be converted to an IBM Cognos map file, the map must meet the following requirements:

- The MapInfo tab files must be referenced by *.gst files.
- Map objects (regions and points) must have an identifier and the identifier must be in the first column of the associated MapInfo table.
- If aliases are defined for the identifiers, they must be in any column except the first column.

Procedure

1. From the File menu, click Import.
   The Map Import Wizard opens.

2. Click Next.

3. On the Specify a map file wizard page, choose the location of the MapInfo files, identify the language that the map was authored in, and then click Next.
   Map Manager reads and then loads the data.

4. On the Select aliases wizard page, do the following:
• Expand the column headings.
• Click the check box for each column, if any, that contains aliases for the features in the first column.

For example, the feature column may refer to Canadian provinces using abbreviations, such as Ont., and another column may use the full name, such as Ontario. These two columns refer to the same map feature. The full-name column is an alias for the abbreviations (feature) column and should be checked.
• In the Layer box, select the next layer, expand the column headings, and select any alias columns that apply.
• Repeat for all layers.
• Click Finish.

After you import the custom map, you can set it up to ensure that it is available for multiple reports.

Preparing Maps for Reuse in Reports

IBM Cognos Map Manager helps report authors or modelers reuse the same map charts across departmental, corporate, and national boundaries. By managing the map files from which the map charts are based, report authors can reuse the content to ensure its consistency and usability. The ability to reuse content contributes to increased quality, and reduced time and costs for development and maintenance.

Use Map Manager to add language support so that users can view feature names on map charts in their preferred language. Use Map Manager to add aliases so that feature names can be correlated to names in corporate databases.

Users can reuse custom maps or the sample IBM Cognos map files in their reports. However, before you can use custom map charts in IBM Cognos Report Studio, you must convert them to IBM Cognos map files by importing them into Map Manager.

Related tasks:
“Import a Map from a Non IBM Source” on page 11

Before you can use a custom map in IBM Cognos Report Studio, you must convert it to an IBM Cognos map file (.cmf). For this release, MapInfo geosets (*.gst) and related files are supported.

Change the Map Image

Preview a thumbnail of the map image that will appear in a report to see how it will look. Depending on your reporting requirements, you may want to change the thumbnail image of the current map. For example, you may want to use a map that was created with non IBM software and saved as an image file.

When you import a map from a non-IBM source, IBM Cognos Map Manager creates a thumbnail image that is a stripped-down version of the map. The default color of the image is determined by the first MapInfo object to be read from the layer. You may want to add color or a name to the thumbnail image or you may want to use an existing thumbnail image.

The requirements for a thumbnail image are that it must be
• In PNG, JPG, or GIF format
• Between 154 by 110 pixels
You can also reset the map image to use the default.

**Procedure**

1. In the **Image** window, click the browse button.
2. In the **Look in** list, click the drive, folder, or Internet location of the new image file.
   The image file must be PNG, JPG, or GIF format.
3. Find the image and click it.
4. Click **Open**.
   The new image appears in Map Manager.
5. From the **File** menu, click **Save**.

**Reset the Map Preview Image to the Default**
Change the preview image back to the default image if the default image better suits your reporting needs.

**Procedure**

To reset the preview image to the default, in the image window, click the restore button.

**Add a Description to a Map**
When a map is used in IBM Cognos Report Studio, it contains a copyright. You can add a description of the map to the copyright information using IBM Cognos Map Manager.

You cannot change the copyright information.

**Procedure**

1. In the **Description** window, click in the **Description** box.
2. Type the description.
3. From the **File** menu, click **Save**.
   The description appears in the Copyright box and in Report Studio when the map is used.

**Add an Alias to the Dictionary for a Map Feature**
You can specify aliases that match data values in your data source to feature names in the map.

For example, a report uses a data source that contains the name Korea, while the map file uses two names: Korea, Republic of, and Korea. Before you can accurately show information, such as revenue for Korea, Republic of, you must create an alias that matches that country to Korea in the data source.

Aliases are also useful when addresses in your data source use abbreviations for city names. You can create an alias for each abbreviation to identify the city they reference.
Report authors can override or add to these multilingual labels in IBM Cognos Report Studio for one-time reporting needs. For example, if multiple regions contain a city that has the same name, you may choose to show only the city in one region by setting up an alias.

**Procedure**

1. In the **Dictionary Entry** window, click the **Language** list and then click the language of the dictionary.
   The map layers and features associated with this language are now available for defining aliases.
2. In the **Layer** box, select the appropriate layer.
   The features in this layer are listed in the **Feature** box.
3. If you want additional information to help identify the features in the layer, select the appropriate layer from the **Refine** layer box.
   Additional information about the feature appears in the **Feature** box in the **Refine** column.
4. In the **Feature** box, select the name of the feature for which you want to add an alias.
5. In the **Alias** box, type the alias and then click the add entry button. The alias is added to the dictionary.

**Find a Map Feature**

You can quickly search for every occurrence of a word or letter sequence in feature names. For example, you can search for a list of cities in the United States with the name Springfield.

**Procedure**

1. In the **Dictionary Entry** window, click the **Language** list and then click the language.
2. In the **Layer** box, select the layer.
3. If required, in the **Refine layer** box, select the appropriate layer to see additional information to help identify the feature.
4. In the **Find** box, type the text that you want to search for.
   The **Feature** box shows the results of the search.

**Adding Language (Locale) Support**

For multilingual support, you can translate the labels for the names of map features to different languages. For example, in IBM Cognos Report Studio, if you have multilingual versions of a report, you can ensure that the map charts are available in the same language as the report.

**Export the Translation File**

The first step in providing multilingual versions of the map labels is to select the languages and make the feature names available for translation. You do this by exporting feature names for all or some selected layers to files that can be used by translators or prepared for translators.

**Procedure**

1. From the **Tools** menu, select **Export Translation File**.
The Export Translation File dialog box appears. The Languages currently in the map box shows the current list of languages. You must export at least one of these languages as the basis for translating the map labels into other languages. As a result, one of the languages in the map file appears in the Languages to be exported box.

2. If there is more than one language in the Languages to be exported box, select any that you do not want and then click the remove button. Tip: Press Ctrl+click to select multiple languages.

3. In the Languages to be added box, select the languages you want the text translated to and then click the add button.

4. In the Languages to be exported box, move the languages to the sequence you want using the up and down arrows.

   In the export translation file, the languages appear as column headings in the order shown.

5. Select whether you want to translate all or some layers.
   - If you want to translate the names of the map features in all layers, click All.
   - If you want to translate the names of the map features only in some layers, click Selected and then in the Layer box, clear the check boxes for the layers you do not want to translate.

6. Click Export.

7. In the Save in list, click the drive, folder, or Internet location that contains the image file that you want to open.

8. In the File name box, enter a new name for the file.

9. Click the Save as type list, and then click the file format that you want to save the file in.

   If you select TXT, the columns are separated by tabs. If you select CSV, the columns are separated by commas.

10. Click Save.

    The feature names are saved in a TXT or CSV file and are ready for translation. We recommend that a TXT file be imported to a Microsoft Excel spreadsheet for the translation. This prevents errors in tabulation between columns. When the translation is complete, the information can be exported back to a TXT file.

    Important: Ensure that you read and write information from Excel using UTF-8 encoding.

    You import the translation file back into IBM Cognos Map Manager after translators have translated the content of the export file.

Import the Translation File

The second step in providing multilingual version of the map labels is to make the translated features names available to users. You do this by importing both the original and translated languages into IBM Cognos Map Manager.

To successfully import the translated feature names, the TXT file must meet the following requirements:

- Feature names must be in the same sequence as they were when you exported the file.
- The file must contain the same number of feature names.
Procedure
1. From the Tools menu, select Import Translation File.
2. In the Look in list, click the drive, folder, or Internet location that contains the IBM Cognos map file (.cmf) that you want to open.
3. In the folder list, locate and open the folder that contains the file to import.
4. Click the file and then click Open.
   The Import Translation File dialog box opens. The language that the translators used for the translation is listed in the Key language in the translation file box.
5. From the Other languages in the translation file box, click the language that you want to import and then click the add button
6. Click OK.
   If you click the Language list in the Description window or in the Dictionary window, it now includes the imported language.

Merge a Customized Map with Another Map
Occasionally, you may want to change the map that you use to represent a geographic area.

If the map you are replacing is customized, you can perform a merge to copy the alias and description to the new map.

Procedure
1. Open the map that you want to use.
2. From the File menu, click Merge.
3. Enter the location of the customized map whose data you want to use, and click Merge.
4. Click OK.
Chapter 4. Acquiring New Maps

IBM supplies a set of standard maps that can be used directly with IBM Cognos Map Manager.

If you already have proprietary geographic data, you can also create your own custom GST files and then import these into Map Manager. To create custom GST files, you must use an application that produces MapInfo files, such as MapInfo Professional.
Chapter 5. Troubleshooting

Use this troubleshooting information as a resource to help you solve specific problems you may encounter when installing or using IBM Cognos Map Manager.

When you are troubleshooting, log files can help you. The IBM Technotes are another valuable troubleshooting tool and are available at the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Problems Importing Files

You may encounter problems when you try to import a map file or text file.

Error Importing Translated Text File

When you import a TXT or CSV file that has been translated, you receive an error message similar to the following:

Unable to save the file.

An error occurred while importing the map file.

Unable to import. The translation file contains no useful content.

The problem may be caused by one of the following:
- The map file that is open is not the map from which you created the export translation file.
- Features were added or deleted in the file.
- Columns (extra tabs or commas) were added to the file.
- The data was sorted and is now in a different sequence than when it was first exported.

To resolve the problem, first ensure that the correct map file is open. If it is, then resend the original exported file for translation and specify that the contents must not be sorted, deleted, added to, or modified except to add translated features. If required, export the translation features and languages again.
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
IBM, the IBM logo, ibm.com, TM1, and Cognos are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "[Copyright and trademark information](http://www.ibm.com/legal/copytrade.shtml)."

The following terms are trademarks or registered trademarks of other companies:

- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
Glossary

This glossary includes terms and definitions for IBM Cognos Business Intelligence.

The following cross-references are used in this glossary:

- See refers you from a term to a preferred synonym, or from an acronym or abbreviation to the defined full form.
- See also refers you to a related or contrasting term.

To view glossaries for other IBM products, go to [www.ibm.com/software/globalization/terminology](http://www.ibm.com/software/globalization/terminology) (opens in new window).

A

access permission
A privilege that permits the access or use of an object.

accountability scorecard
A scorecard that Metric Studio automatically builds for each user which contains the metrics and projects they own.

agent
A process that performs an action on behalf of a user or other program without user intervention or on a regular schedule, and reports the results back to the user or program.

alias
An alternative name used instead of a primary name.

anonymous access
A type of access that allows users and servers to access a server without first authenticating with it.

application tier component
For installation, the set of processors that access the query databases to gather information and then render the results as PDF and HTML reports and metrics. Application tier components also pass requests to Content Manager and render the results that Content Manager retrieves from the content store.

attribute
In BI Modeling, a characteristic of an entity which is descriptive rather than a unique identifier or an aggregative measure.

authentication
The process of validating the identity of a user or server.

authentication provider
The communication mechanism to an external authentication source. Functionalities, such as user authentication, group membership, and namespace searches, are made available through authentication providers.

B

burst
To create several report results by running a single report once. For example, the user can create a report that shows sales for each employee, and run it once, sending different results to regional managers by bursting on region.

burst key
The dimension or level of a query in the report specification that is used to create, or burst, a set of report results.

C

CA
See certificate authority.

calculated member
A member of a dimension whose measure values are not stored but are calculated at run time using an expression.

canvas
An area within a dashboard or workspace that users interact with to create, view, and manipulate content and data.

capability
A group of functions and features that
can be hidden or revealed to simplify the user interface. Capabilities can be enabled or disabled by changing preference settings, or they can be controlled through an administration interface.

**cardinality**

1. For relational data sources, a numerical indication of the relationship between two query subjects, query items, or other model objects.
2. For OLAP data sources, the number of members in a hierarchy. The cardinality property for a hierarchy is used to assign solve orders to expressions.

**cascading prompt**

A prompt that uses values from a previous prompt to filter the values in the current prompt or pick list.

**certificate**

In computer security, a digital document that binds a public key to the identity of the certificate owner, thereby enabling the certificate owner to be authenticated. A certificate is issued by a certificate authority and is digitally signed by that authority. See also [Certificate authority](#).

**certificate authority (CA)**

A component that issues certificates to each computer on which components are installed.

**CGI** See [Common Gateway Interface](#).

**cipher suite**

The combination of authentication, key exchange algorithm, and the Secure Sockets Layer (SSL) cipher specification used for the secure exchange of data.

**class style**

A combination of formatting characteristics, such as font, font size, and border, that the user names and stores as a set.

**CM** See [Content Manager](#).

**Common Gateway Interface (CGI)**

An Internet standard for defining scripts that pass information from a web server to an application program, through an HTTP request, and vice versa.

**condition**

An expression that can be evaluated as true, false, or unknown. It can be expressed in natural language text, in mathematically formal notation, or in a machine-readable language.

**constraint**

1. A security specification that denies one or more users the ability to access a model component or to perform a modeling or authoring task.
2. A restriction on the possible values that users can enter in a field.

**contact**

A named email address to which reports and agent e-mails can be sent. Contacts are never authenticated.

**content locale**

A code that is used to set the language or dialect used for browsers and report text, and the regional preferences, such as formats for time, date, money, money expressions, and time of day.

**Content Manager (CM)**

The service that retrieves information from the content store, and saves information to the content store.

**content store**

The database that contains the data needed to operate, such as report specifications, published models, and security rights.

**credential**

A set of information that grants a user or process certain access rights.

**cube**

A multidimensional representation of data needed for online analytical processing, multidimensional reporting, or multidimensional planning applications.

**custom set**

In Analysis Studio, a named object which can include filter rules, calculations, and sort rules. Custom sets can define a set of members that is different from any set originally defined in the cube model. See also [predefined set](#)
D

dashboard
A web page that can contain one or more widgets that graphically represent business data.

data source
The source of data itself, such as a database or XML file, and the connection information necessary for accessing the data.

data source connection
The named information that defines the type of data source, its physical location, and any sign-on requirements. A data source can have more than one connection.

data tree
Within a studio, a structure that contains objects such as query subjects, query items, dimensions, levels, and members. A data tree is used as a palette of the available data that can be inserted into calculations, filters, display areas, and other authoring gestures.

deployment
The process of moving an application (such as a report or model) to a different instance. For example, reports are often created in a test environment and then deployed to production. When an application is deployed, it is exported, transferred, and imported.

deployment archive
A file used for deployment. A deployment archive contains the data from the content store that is being moved.

deployment specification
A definition of what packages to move (deploy) between source and target environments, the deployment preferences, and the archive name. Deployment specifications are used for import and export.

derived index
A calculated metric that provides a status and a score based on other metrics.

details-based set
A set based on an item and its immediate details. See also set.

dimension
A broad grouping of descriptive data about a major aspect of a business, such as products, dates, or locations. Each dimension includes different levels of members in one or more hierarchies and an optional set of calculated members or special categories.

dimensional data source
A data source containing data modeled using OLAP concepts, including dimensions, hierarchies, and measures.

drill down
In a multidimensional representation of data, to access information by starting with a general category and moving downwards through the hierarchy of information, for example from Years to Quarters to Months.

E

event
A change to a state, such as the completion or failure of an operation, business process, or human task, that can trigger a subsequent action, such as persisting the event data to a data repository or invoking another business process.

event key
A combination of data items that uniquely defines an event instance. Identifying an event instance enables the agent to determine if it is new, ongoing or stopped.

event list
The set of detected event instances evaluated by the task execution rules to determine which agent tasks should be performed.

F

fact
See measure

G

gateway
An extension of a web server program that transfers information from the web server to another server. Gateways are
often CGI programs, but may follow other standards such as ISAPI and Apache modules.

glyph The actual shape (bit pattern, outline) of a character image. For example, italic A and roman A are two different glyphs representing the same underlying character. Strictly speaking, any two images which differ in shape constitute different glyphs. In this usage, glyph is a synonym for character image, or simply image (The Unicode Standard – Version 1.0).

group A collection of users who can share access authorities for protected resources.

grouping In reporting, the process of organizing common values of query items together and only displaying the value once.

H

hierarchy The organization of a set of entities into a tree structure, with each entity (except the root) having one or more parent entities and an arbitrary number of child entities.

I

information card A display of high-level information about dashboard, workspace, or report content, such as owner, contact information, date modified, and an optional thumbnail view of the dashboard, workspace, or report.

information pane In Analysis Studio, a pane that helps the user to confirm their selection in the data tree by displaying related information, such as the level and attributes.

initiative A task developed to achieve objectives or close the gap between performance and targets. Initiatives are associated with individual objectives and often known as projects, actions, or activities.

item See member

J

job A group of runnable objects, such as reports, agents, and other jobs that the user runs and schedules as a batch.

job step The smallest part of a job that can be run separately. A job step can be a report or it can be another job.

L

layout The arrangement of printed matter on a screen or page, including margins, line spacing, type specification, header and footer information, indents, and more.

level A set of entities or members that form one section of a hierarchy in a dimension and represent the same type of object. For example, a geographical dimension might contain levels for region, state, and city.

locale A setting that identifies language or geography and determines formatting conventions such as collation, case conversion, character classification, the language of messages, date and time representation, and numeric representation.

M

MDX See Multidimensional Expression Language

measure A performance indicator that is quantifiable and used to determine how well a business is operating. For example, measures can be Revenue, Revenue/Employee, and Profit Margin percent.

member A unique item within a hierarchy. For example, Camping Equipment and 4 Man tent are members of the Products hierarchy.

metric A measure to assess performance in a key area of a business.

metric extract A set of mappings between an existing Cognos data source and a Metric Studio object or value. For example, a cube
measure named Revenue is mapped to a Metric Studio metric named Revenue Actual Value.

metric package
In Cognos Connection, a representation of a Metric Studio application. A metric package contains connection information, reports, and metric management tasks for that application. See also package.

metric store
A database that contains content for metric packages. A metric store also contains Metric Studio settings, such as user preferences.

metric type
A category of metrics that defines the business rules such as performance pattern, units, and meaning of a group of metrics. For example, Revenue can be a metric type, and European Revenue and North American Revenue would be metrics of this type.

model
A physical or business representation of the structure of the data from one or more data sources. A model describes data objects, structure, and grouping, as well as relationships and security. In Cognos BI, a model is created and maintained in Framework Manager. The model or a subset of the model must be published to the Cognos server as a package for users to create and run reports.

multidimensional data source
See dimensional data source.

Multidimensional Expression Language (MDX)
The multidimensional equivalent of Structured Query Language (SQL).

N

named set
See predefined set.

namespace
A part of the model in which the names may be defined and used. Within a namespace, each name has a unique meaning.

news item
A single entry in a Really Simple Syndication (RSS) compatible format. It can include a headline, text, and a link to more information. A news item task in an agent can be used to create news items for display in a Cognos Connection portlet.

O

object
In Report Studio, an empty information container that can be dragged to a report from the Toolbox tab and then filled with data. Reports are made up of objects, which include crosstabs, text items, calculations, graphics, and tables.

object extract
An extract that defines the metadata for a Metric Studio object, such as a user defined column, a scorecard, or a data source.

P

package
A subset of a model, which can be the whole model, to be made available to the Cognos server. See also metric package.

page set
In Report Studio, a set of one or more designed pages which repeat in the report output for each instance of a chosen query item. See also set.

passport
Session-based information, stored and encrypted in Content Manager memory, regarding authenticated users. A passport is created the first time a user accesses Cognos 8, and it is retained until a session ends, either when the user logs off or after a specified period of inactivity.

portlet
A reusable component that is part of a web application that provides specific information or services to be presented in the context of a portal.

predefined set
A set of members defined inside an OLAP data source as a list or by an expression. Predefined sets can be used in analysis and report authoring. See also custom set.

product locale
The code or setting that specifies which language, regional settings, or both to use for parts of the product interface, such as menu commands.
project
1. In Metric Studio, a task or set of tasks undertaken by a team and monitored on a scorecard. A project tracks dates, resources, and status.
2. In Metric Designer, a group of extracts. Each extract contains the metadata that is used to populate the Metric Studio data store or to create applications.

prompt
A report element that asks for parameter values before the report is run.

properties pane
Within a studio, a pane that provides an overview of the properties for selected data. The properties pane can also be used to make several changes and apply them at the same time, instead of repeating several different commands.

publish
In Cognos BI, to expose all or part of a Framework Manager model or Transformer PowerCube, through a package, to the Cognos server, so that the data can be used to create reports and other content.

Q
query
The simple report specifications created and edited by Query Studio.

query item
A representation of a column of data in a data source. Query items may appear in a model or in a report and contain a reference to a database column, a reference to another query item, or a calculation.

query subject
A named collection of query items that are closely functionally related. Query subjects are defined using Framework Manager to represent relational data and form the set of available data for authoring reports in Query Studio and Report Studio. A query subject is similar to a relational view in that it can be treated as a table but does not necessarily reflect the data storage.

R

Really Simple Syndication (RSS)
An XML file format for syndicated web content that is based on the Really Simple Syndication specification (RSS 2.0). The RSS XML file formats are used by Internet users to subscribe to websites that have provided RSS feeds. See also Rich Site Summary.

repeater
In Report Studio, a cell container that repeats values within itself with no predefined internal structure.

repeater table
In Report Studio, a table-like container that repeats cells across and down the page or row in the associated query.

report
A set of data deliberately laid out to communicate business information.

report output
The output produced as a result of executing a report specification against a data set.

report specification
An executable definition of a report, including query and layout rules, which can be combined with data to produce a report output.

report view
A reference to another report that has its own properties, such as prompt values, schedules, and results. Report views can be used to share a report specification instead of making copies of it.

response file
An ASCII file that can be customized with the setup and configuration data that automates an installation. During an interactive installation, the setup and configuration data must be entered, but with a response file, the installation can proceed without any intervention.

Rich Site Summary (RSS)
An XML-based format for syndicated web content that is based on the RSS 0.91 specification. The RSS XML file formats are used by Internet users to subscribe to websites that have provided RSS feeds. See also Really Simple Syndication.

RSS
S

score  A number or ranking that expresses applicability in relation to a standard.

scorecard  A collection of metrics representing the performance of one unit or aspect of an organization.

scorecard structure  The hierarchy of scorecards that reflects how an enterprise organizes its metrics.

security provider  See authentication provider.

selection-based set  A collection of individual items that the user has explicitly selected. The items or members may be selected from one or more levels of the same hierarchy. See also set.

session  The time during which an authenticated user is logged on.

set  A collection of related items or members. Members in a set may be specifically chosen, or selected by one or more filter rules. See also custom set, details-based set, page set, predefined set, selection-based set, stacked set.

stacked set  Two or more sets arranged one above another in rows or side-by-side in columns. See also set.

strategy  The overall plan of action (such as for a brand unit, business unit, channel, or company) to achieve a stated goal. Strategies normally cover a period of more than one year.

strategy map  In Metric Studio, a visual representation of the strategy and the objectives of that strategy for an organization. For example, a strategy map may show employees how their jobs are aligned to the overall objectives of the organization.

summary  In reporting and analysis, an aggregate value that is calculated for all the values of a particular level or dimension. Examples of summaries include total, minimum, maximum, average, and count.

T

task  An action performed by an agent if the event status meets the task execution rules. For example, an agent can send an email, publish a news item, or run a report.

task execution rule  A user-specified option within an agent that determines which statuses and values cause a task to be run. It determines which tasks to execute for each event instance.

template  In report authoring, a reusable report layout or style that can be used to set the presentation of a query or report.

thumbnail  An icon-sized rendering of a larger graphic image that permits a user to preview the image without opening a view or graphical editor.

tuple  An ordered collection of two or more members from different dimensions. For example, the tuple (2007, Camping Equipment, Japan) returns the value for the intersection of the three members: 2007, Camping Equipment, and Japan. Tuples can be used to filter and sort data, and to create calculations.

U

union set  See stacked set.

user  Any individual, organization, process, device, program, protocol, or system that uses the services of a computing system.

user-defined column  In metric management, a column used to represent a value other than the actual or target. It may be an industry benchmark or any other useful additional numerical information for a period, including a calculation based on the other values of the metric. User-defined columns may be different for each metric type.
watch list
A list of metrics that each user has chosen to monitor closely. If notification is enabled in Metric Studio, the user will receive email notification of changes to these metrics. Users can also choose to display their watch list as a portlet within Cognos Connection.

watch rule
A user-defined condition that determines whether a report is delivered to the user. When the rule is run, the output is evaluated and, if it satisfies the condition or rule, the report is delivered by email or news item. Watch rules limit report delivery to those reports containing data of significance to the user.

Web Services for Remote Portlets
A standard for creating presentation-oriented web services so that they can be easily integrated within other applications, such as web portals.

widget
A portable, reusable application or piece of dynamic content that can be placed into a web page, receive input, and communicate with an application or with another widget.

work area
The area within a studio that contains the report, analysis, query, or agent currently being used.

workspace
See dashboard
Index

A
aliases 14

B
base language 5

copyright of maps 13
CSV file requirements 16
custom layers 8

default map preview images 13
description of map 13
dictionary 5, 14
disk space 3

E
environments supported 3
errors
importing translation files to Map Manager 19
European map
boundary changes 1
exporting
translation files 14

F
features 5

G
glossary 25

I
importing
non IBM maps 11
translation files 16
India map
boundary changes 1
installing Map Manager 3

L
layers 5
creating custom 8
locales
adding 14
log files
installation 3
troubleshooting 19

M
map charts and Report Studio 7
map features
adding aliases to the dictionary 14
finding 14
map folders
creating for Report Studio 10
Map Manager
importing files 19
importing translated text files 19
maps
adding 17
adding a description 13
adding to a map folder 9
boundary changes 1
copyright information 13
importing 11
map folders
adding maps 9
merging 16
opening 8
preparing for use in reports 12
previewing image 13
Report Studio
adding maps 9
resetting the preview image 13
saving 9
upgrading 16

N
new features 1
non IBM maps
importing 11

O
operating system 3

P
previewing map images 5, 13

R
Report Studio
changing Choose Map dialog 9
changing folders in Choose Map dialog 10
map description 13
using map charts 7
requirements
for TXT and CSV files 16
system 3

S
searching map features 14
source of new maps 17

© Copyright IBM Corp. 2005, 2012
starting Map Manager 8
system requirements 3

T
text files
  exporting 14
  importing 16
thumbnail view 13
translation files
  exporting 14
  importing 16
problems importing into Map Manager 19
troubleshooting 19
TXT file requirements 16

U
uninstalling Map Manager 4

W
world map
  boundary changes 1